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We've been very busy planning ways to help you enhance or start a successful garment deco-
rating business. We now offer online training in the convenience and comfort of your home
or office; an exciting new business opportunity in the photo kiosk industry; an affordable,
downloadable collection of top-quality artwork for your GT-541 inkjet printer; and a newly
revised and improved curriculum for our nationwide garment decorating road shows.
Succeeding in this industry just keeps getting easier! 

Online Industrial Embroidery Software Training
Brother has launched a comprehensive online training program on the full suite of Brother
embroidery software products, led by Brother software specialists. In addition, you have the
option to be guided through an online Ethos Software demonstration (navigating a promotional
CD can be frustrating), plus receive online help from a specialist for any software related
issues that cannot be resolved over the phone.

Brother embroidery software/Ethos online training is provided free of charge for one year
after software installation, for up to two people per company. The comprehensive educational
classes teach users to properly utilize their embroidery software. During these classes, the
user's mouse can be activated to fully function with the trainer's software shown on their
monitor, providing hands-on-training rather than watching someone perform the functions.
Classes are four hours each day; two hours in the morning and two hours in the afternoon
(EST and CST). The first two days are for lettering and editing, and the second two days
cover digitizing.

This online training saves users the costly time and expense of travel and hotel costs by
allowing them to take these classes in the comfort of their home or office. To sign up for
online training, users must have a high speed internet connection, dedicated landline and
someone to "run the store" while they are training. For more information, call 1-877-427-6843.

End-to-End Photo Gift Kiosk Solution
Recently Brother and Storefront.com, a leading developer of business software and services
directly related to the Digital Imaging and Kiosk industries, announced a turnkey end-to-end
digital imaging and printing solution to the photo industry. This is an exciting new business
opportunity for those starting a new business or just thinking of adding photo products to an
existing product line.

Storefront.com has been successfully providing photo kiosk interface products, including
seamlessly integrated front-end design tools, to many Fortune 500 retailers. Their Print and
Gift Station is a photo kiosk application that accepts orders for photographic prints and other
products made from consumer images and can be run as a stand-alone kiosk or be operated
in a staff assisted manner. With this solution, customers can upload photos, edit them, add text,
and print on garments - in a matter of minutes (heat press required). If you're not familiar
with the Brother GT-541 on-demand inkjet garment printer: it prints up to 14" x 16" graphics,
is simple to operate, and prints beautiful, lifelike high-resolution full color graphics using
water-based pigment inks that withstand repeated washings. Images can be supplied on
memory cards, USB devices, CDs/DVDs, camera phones, PDAs, digital cameras, or by
scanning. The customer can then edit and enhance their images by adjusting color, brightness
and contrast, removing red eye, cropping, rotating, and automatic color correction directly
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Cover SStory . .. ..  (continued)

from the convenient touch screen.  Adding text is easy, and there are many font, color, and text enhancement fea-
tures available. The order management feature completely controls the ordering and payment processes, including
adding the appropriate taxes and providing customer receipts.

Storefront’s VP of Sales and Marketing notes, “The pairing of Brother’s revolutionary, direct-to-garment inkjet
printer with Storefront’s award-winning, photo-kiosk software creates a very powerful retail solution that provides
retailers and franchise owners new opportunities in retail imaging.”

Retailers can increase sales by providing additional service offerings, improve profit margins with higher margin
products, help improve service with product previews available prior to printing, and secure credit card processing.

Graphic Design Tool and High Quality Artwork Collection for GT-541 Owners
Owners of the Brother on-demand inkjet garment printer GT-541 will soon have access to a simple-to-use graphic
design program plus a large collection of licensed artwork designed to enhance and accelerate the GT-541 owner
experience. PDQ™ (Professional Designs Quickly) is a tremendous value for garment decorators because they can
now quickly and professionally design garments without paying high licensing fees and struggling with hard-to-
learn graphics programs. Simply choose a garment, place the design using a predetermined template, add text and
enhancements, and print. Best of all, the software is free and you only pay a small per-print fee. Owners gain 24/7
access to thousands of original graphics by simply going online and downloading chosen designs. Stop paying 
for low quality, high cost graphics for your business - we’ll give you a comprehensive library of beautiful designs.
The only requirement is that you run Windows and have access to the internet.

On the Road Again 
Beginning in April, we are starting the third tour of our highly popular Garment Decorating Road Shows, taking
place in many conveniently located cities across the country. Attendees will learn how to expand their business
model, increase their customer base, diversify their garment decorating services, and create new and dynamic
design offerings. Give us thirty minutes and we'll demonstrate the advantages and features of our embroidery and
inkjet printing machines, machine operation (hands on interaction: attendees can bring their own designs and
watch them print!), how to build a business around "on demand" printing, and how to put new sales power in
your business. New this year is the addition of the GT-541 seminar. Here's your opportunity to have all your garment
decorating questions answered. These informative road shows are perfect for those looking to start a garment
decorating business or to expand an existing one. For a complete listing of road show dates and locations, visit
www.brother.com. 

If you'd like additional information, please call 1-800-432-3532.

Notes ffrom tthe EEditor
Dear Readers:

I hope that 2008 has started out well for all of you. As you can see from our cover story, we've got lots of excit-
ing new offerings for you to take advantage of. If you need more information or want to sign up for a road show,
please call 1-800-432-3532. Check our website, www.brother.com, often for up-to-date information about shows,
training, etc. We are continually updating and adding new information as it becomes available.

If you'd like to share your garment decorating business success story with us - and our readers - please email
or call me. We'd love to hear your ideas and strategies for operating a successful garment decorating business in a
challenging economy.

Also, feel free to nominate yourself (or a business associate) for Customer of the Quarter. It's
great advertising for you, plus you receive a free P-touch labeler for participating. I look forward
to hearing from you soon.

Lisa Pross
Marketing and Operations Manager
Industrial Products Division
lpross@brother.com
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Dear Doctor,

I am trying to run a cap with two designs, one on
the front with another one on the side. When I do
the trace, it's not tracing in the proper position.
How can I do this without driving myself crazy?
Gettin' kind of "rummy".

Cap'n Morgan       

Dear Cap'n,

You didn't say which software you were using so I
will explain it for both. Using the BE-100 software
you want to start with a new design. When the Design
Info box comes up you want to click on the Parameters
tab and then click the down arrow below Method
where it says Center. Change this to Choose and it
should default to zero zero for the X and Y locations
on your screen. If you can't see the Start\Stop position
go to Views and Markers, then click a check mark next
to Start\Stop position. This will show the start and end
position for the entire design. Then go to File and
Merge and bring in the first design that you want to
run on the front of the cap. Merging the design will
center it over the Start\Stop position. Next go to File
and Merge and bring in the second design that you want
on the side. It will merge right on top of the other one.
Click on your Move tool and move it to the right or
left depending on which side you want the other logo.
(If you hold down your Shift key while moving the
second design it will move left and right without moving
vertically). Once you have it in the proper position, just
save and then output. Now the design will run the first
design in the center of the cap then move over and sew
the second design on the side, then move back to the
center of the cap.

For the Ethos software you need to open your first
design that you want to sew on the front of the cap, then
you need to set your Origin (this is the same as Start\
Stop) by clicking on the icon or going to Edit and Move
Origin. Once you have clicked on this you can hold
down your Shift key and left click and this will center
the origin for that design. Next you need to open your
second design and Copy and Paste it into the screen
with your first design and place it to the left or right,
lining it up using the grid lines or guide lines. When
doing this kind of layout you do not want to Finalize
the Design or it will put the origin in the middle between
the two designs. I would recommend using the Tidy-up
feature to delete the small stitches that are usually
deleted when you use the Finalize Design feature. You
will find this feature under Stitches, Design, and Tidy-
up. Then save your design and then Export it to sew.

Happy Stitching!

Design Doctor

Design DDr.GT-5541 TTech TTalk

Going Somewhere???
Do you want to take your GT-541 on the road for an
event? If you follow the following procedures you can
successfully take your printer with you.

1.  Purchase a GT-541 Moving Kit (SA5719001).

2.  Contact Brother or your authorized distributor for
the instructions on how to properly move your 
printer.

3.  Follow the simple instructions step-by-step for
proper tear down.

4.  Secure your printer in the vehicle.

5.  Arrive at your destination and unpack your printer.

6.  Follow instructions step-by-step for proper setup.

At the end of your event, follow the simple instruc-
tions again to return your printer to your place of
business. The procedures have been designed to ensure
you arrive to your event and back without damage to
your unit. We understand taking your unit with you
gives you the opportunity to make money while on the
road.  

Brother recommends when transporting the GT-541
you use a vehicle that is very stable and has a
good suspension system to reduce some of the vibra-
tion that will occur during driving. 

Always know Brother is here to assist you in being
successful in your business.

For Technical Assistance, please call toll-free
1-877-4BROTHER or 

Email tsupport@brother.com.
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that is where the Brother GT-541 excels. "It's given me
the opportunity to expand my screen-printing business
by allowing me to offer small quantities at affordable
prices. The GT-541 added another solid profit center to
our business," says Robert. "We became immensely
more profitable because of the GT-541. Most of the time
when we take small jobs, they lead to much larger jobs.
In other words, it's opened up new opportunities for us.
It's as easy to operate as a desktop printer. The support is
great, but I haven't needed much support with this
machine. This is a must-have piece of equipment for
anyone in the garment decorating industry!"

What brings Jackie and Robert the most satisfaction
from their work? Passing people on the street who are
wearing their designs. "We were at Madison Square
Garden in New York City and I saw someone wearing a
jacket I designed and sewed for a martial arts school. I
was so proud and excited. It was a great feeling…really
cool. We've been out to dinner or the movies or the mall
and have seen people wearing our designs and it's an
awesome feeling. Really proud and fulfilling," exclaims
Jackie.

No Experience?
Not a Problem for Logo Gear.

Ten years ago, at the suggestion of a neighbor (who
happened to be a Brother employee), Jackie Tobia
decided to start an embroidery business - Logo

Gear, Inc. The only problem was that she had no idea
how to sew or how to thread a machine. She didn't even
know what a bobbin was, but she was determined to
learn and to succeed. Her first industrial embroidery
machine was the Brother BAS-416, a single head, 12-
needle model. Today, Jackie and her husband, Robert,
are enjoying enormous success with their three single-
head 12-needle and one portable (PAS-600C) single
head Brother embroidery machines, plus a Brother
GT-541 inkjet garment printer.

Jackie and Robert moved their home-based business
to a retail location in Martinsville, New Jersey four
years ago to accommodate their rapid growth. Jackie
continues to do most of the embroidery from her home
shop because it is more convenient for her, while Robert
operates the GT-541 and fields calls at the storefront
location. Logo Gear continues to grow, mostly due to
Jackie's constant promotion of their business. "I sell our
business to everyone I come in contact with, from the
carpenter and plumber to the butcher and little league
coach. I tell people they should be advertising THEIR
company on their shirts, not a designer, band, movie,
etc. It really works," says Jackie. Jackie credits her success
to rapid turnaround time, excellent customer service and

the fact that people (customers) like using local services.
Her customers are varied and include local sports teams,
small local businesses, neighbors, and several large
corporations. Jackie does most digitizing in-house, but
she outsources more complicated designs. Not bad for
someone who didn't even know what a bobbin was!  

"I love Brother. Not only is their customer service
excellent, but I can get support until 8:00 pm, long after
my business has closed," said Jackie. Jackie is contem-
plating purchasing a 4-head embroidery machine to
keep up with the demand, and says she wouldn't consider
any other machine than a Brother.

While Jackie is busy with the embroidery side of the
business, Robert concentrates on the screen-printing and
inkjet garment printing side of Logo Gear. Robert says
that a lot of jobs are not right for screen-printing and

Customer oof tthe QQuarter...continuedCustomer oof tthe QQuarter

2007 SSoftware
Training SSchedule

10. Yearly Updates - ApS-Ethos will come out with a
new software version every year.

9. ApS-Ethos works with Windows XP Pro, XP Home
and Windows Vista.

8. When you upgrade to ApS-Ethos you get a new USB
Security device.

7. ApS-Ethos will read your old BE100E .bdf files.
6. ApS-Ethos works with vector art.
5. ApS-Ethos gives you the flexibility of using many

different text features.
4. ApS-Ethos has an automatic drop-shadow feature.
3. True type fonts for running and fill stitch.
2. Free software training on all upgrades.
1. Fonts, Fonts, Fonts......Almost 200 satin fonts.

Top Ten reasons to upgrade from 
BE100 to ApS-Ethos

Please call 1-877-4BROTHER (877-427-6843) or
(901) 379 1085 to sign up for ApS-Ethos

Software training.
For the 2007 schedule, visit www.brother.com (click Go
to U.S.A; click Industrial Sewing & Embroidery; click
Brother University & Seminars; and click Software
Seminars). Class sizes are limited, so early enrollment is
encouraged.

“The GT-541 added another
solid profit center to our

business. We became
immensely more profitable
because of the GT-541.”
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M E M B E R

Call us at 1-800-432-3532 if you have any
questions or would like additional details

about a particular tradeshow or roadshow.

TRADE SSHOW AAND
CONVENTION SSCHEDULE

The PPAS Store

Apr. 11-12 Network 2008, Dublin/Columbus, OH TBA

May 8-10 Printwear, Fort Worth, TX 115

July 17-19 Printwear, Long Beach, CA 327

Get Instant Access to Show Details!
We’ve updated our website to provide links to trade

shows, exhibitor websites, and the roadshow schedule.
Visit www.brother.com to access our Trade Show
Schedule page and simply click on the link of the
show you’re interested in. (Click Go to U.S.A.; click

Industrial Sewing & Embroidery; click Show Schedules; and
click on the Trade Show Schedule tab)

June 19-21 Printwear, Baltimore, MD 109

2008

July 18-20 ISS, Providence, RI 705

Aug. 7-9 ISS, Schaumburg, IL 506

Sep. 11-13 ISS, Atlanta, GA 406

Sep. 4-6 Printwear, Indianapolis, IN 115

Mar. 28-29 DAX, Minneapolis, MN 311-313

Apr. 4 Stitches Road Show, Detroit, MI TBA

Apr. 10-12 Printwear, Charlotte, NC 219

Apr. 15 Stitches Road Show, Denver, CO TBA

May 17-20 Nat’l Restaurant Show, Chicago, IL 5258

June 9-11 SGMA - Sporting Goods, Las Vegas, NV TBA

Aug. 15-16 NNEP Embroidery Mart (East), 
Nashville, TN

TBA

Sep. 25-28 Digital Life, New York, NY 1016

Oct. 10-12 ISS, Fort Worth, TX 404

Oct. 15-18 SGIA, Atlanta, GA 3363

Nov. 13-16 IAAPA Attractions Expo, Orlando, FL TBA

Satin Serial

Satin Serial is an Ethos feature that allows you
to punch a running stitch and turn it into a satin
stitch. 

First select the running stitch tool. Then
punch your running stitch and before you right
click to quit, press the “f” key on your key-
board. This will allow you to select any point
and drag it out to make the satin stitch. You can
also press the “N” key to type in the width of
your satin. You can then continue punching as
if you started punching with the satin tool.
Also,  if you press a capital “F”, you can drag
the satin to the other side of the running stitch
that you started with. The “N” key works with
this feature as well. 

Ethos SSoftware
Tips

If you have any questions about this or any
other Ethos topic, please call toll-free

1-877-4BROTHER or 
Email tsupport@brother.com.
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Need Help?
FOR PRODUCT INFO:
800-432-3532

TECHNICAL AND 
SOFTWARE SUPPORT:
Toll Free: 1-877-427-6843
Email: tsupport@brother.com

(Machine support)
ssupport@brother.com 
(Software support)

Embroidery Groups

SALES REPRESENTATIVES

STEVE HOBBS
(CT, DC, DE, IA, IL, IN, KY,
MA, MD, ME, MI, MN,
Eastern MO, NH, NJ, NY, OH,
RI, VA, WV, VT, WI, PA)
Phone: 603-772-3224
Fax: 603-772-4665
Cell: 603-422-1237
Toll Free: 888-729-3224

JACQUELINE PLACHTA
(AL, FL, GA, MS, NC, 
TN, SC, Latin America) 
Phone: 561-395-7425
Fax: 561-395-7424
Cell: 954-612-0039

TODD SOMMERS
(AR, AZ, KS, LA, Western MO, 
NM, OK, TX)
Phone: 214-547-9476
Fax: 214-547-9478
Cell: 214-505-5496

BILL SWEEN
(AK, CA, CO, HI, IA, ID, MN,
MT, ND, NE, NV, OR, SD, UT,
WA, WY)
Phone: 801-270-0800 or

888-899-7306
Fax: 801-912-1178
Cell: 801-556-4891

Embroidery Offices

NEW JERSEY
Corporate Office
100 Somerset Corporate Blvd.
Bridgewater, NJ  08807
908-252-3279

CALIFORNIA
26250 Enterprise Court
Suite 250
Lake Forest, CA 92630 
949-859-9700 Ext. 278
Fax 949-583-9473

ILLINOIS
1300 Remington Road
Suite D
Schaumburg, IL 60007
847-718-9500
Fax 847-718-9503

MASSACHUSETTS
Corporate Place 93
No. 1 – Suite 210 
100 Burtt Road
Andover, MA 01810
978-475-3081
Fax 978-470-0541

TENNESSEE
(Warehouse, Parts, 
Distribution & Services)
7777 No. Brother Boulevard 
Bartlett, TN 38133 
901-379-1000 Ext. 1093
Fax 901 379-1226 

BROTHER INT’L CORP. 
U.S. SUBSIDIARY:
MIM Industries, Inc. 
4301 Lyons Road 
Miamisburg, OH 45342 
937-866-4478 Ext. 6997
Fax 937-859-6944 

For Technical Assistance, please call toll-free
1-877-4BROTHER or 

Email tsupport@brother.com.

Embroidery TTech TTalk
Setting Top Tension Knobs

For Brother models:
101,116,401,416,1210,916,901,1216,
1201,423,1230,1240,960,1260,1262

Pull the thread downward from the needle, and
get a "feel" for the tension. The thread should
have a smooth consistent drag as you pull it.
Follow the path of the thread, as you pull it, from
the spool through the sewing head, looking for
any mistakes in the thread path (i.e., is the thread
break sensor wrapped, thread snags, etc.).

There are two styles of pre-tensioners; A: the
metal knob type found on 9-needle machines,
and B: the white plastic knob found on 12-needle
machines.

A: B:

Position the knobs as shown in the above
cross-section diagrams. The metal knob type
should be set so the split in the silver post is com-
pletely above the metal knob. The plastic knob
type should be set so the silver metal post is flush
with the inner ledge in the knob. This is how the
pre-tensioners should be set for all types of thread
(e.g. rayon, polyester, cotton).

To set the main tension knob, first turn the
knob so the black post is flush with the inner
ledge as shown in the cross-section diagram
above. If you are using Rayon thread, turn the
tension knob between 1 & 2 turns clockwise from
the "flush" position. If you are using Polyester
thread, turn the main knob 2 ½ to 3 ½ turns
clockwise from the flush position. If you are
using Cotton or poly-cotton wrap thread, turn the
main knob 4 full turns or until the black post is
flush with the top of the tension knob.

If you have to deviate from these settings, it is
likely the thread path is incorrect, you may have
bad thread, or there may be burrs along the eye-
lets in the thread guides.  



First of all, you will need to edit the step effect you
wish to use or create a new one (as normal). Now select
the Advanced button, you will now see another button
“Edit Block Vector” (amongst the advanced settings).
Click on this button. This will now launch a window
into which you can digitize your vector shapes. This has
a main toolbar as shown below.

7
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ApS-EEthos

Questions? Comments? Email Toby
at readers.advice@brother.com

Block Vectors in Shapes

Click on the Edit menu and select Add Vector. You
can now digitize a shape in the normal manner. Make
sure you press TAB to close the shape at the end. In this
example we shall create a diamond then a circle.
Pressing the right-mouse-button after pressing TAB will
allow you to digitise another shape, in this case we shall
create a circle after the diamond. Pressing the right-
mouse-button a second time will exit from the digitizing
tool. The Edit->Edit Vector menu option will allow
existing vectors to be point edited.

When you are satisfied with the vectors you have
created you should now select Save & Exit. This will
save the vectors to the effect. Whenever the effect is
now used it will generate the pattern shown at the
beginning of this document. The vectors can be re-edited
at anytime by clicking on the “Edit Block Vector” button.

In this example we will
create a fill effect which
produces this pattern:

Important Note: This feature is only
available if you have Advanced effect set-
tings. Designs using these vector patterns
are not compatible which Ethos V4.0 or
lower.

Set the Background
Color of the DesignWith V4.1 of Ethos, stitch effects can now be set up to

contain block vector outlines. This allows for more flex-
ible and reuseable effects. Below is an example. Ethos allows the background color of the design window

to be set to a color of the users choice and allows this
color to be turned on and off as required. The color will
also be printed out on any design printouts produced by
the system. To set the background color, simply select Set
Background Color from the Window menu.

This will display the general color palette tool as sup-
plied with Windows.

Predefined set colors, select one of these,
or one from the custom color list.

Custom color
visual palette.
Click on here to
select a color.

Shade slider, click
on here to vary
shade.

Numerical input
for custom color.

Click here to put selected
custom color into custom
color list on left.

Selected custom
color.

Click this
button to
expand
the dialog
to it's
fullest.

Custom
color list.

Select or mix your own color as required, then press
OK. This will set the background color. To switch the
background color off, simply select the Background
On option in the Windows menu.



Industrial Products Division
P.O.Box 6911
Bridgewater, NJ 08807-0911
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Don’t MMiss OOut! SSign UUp TToday!
Brother International Corporation

Sign up Today and Don’t Miss a Single
Copy of Brother’s Print & Sew Quarterly!

Stay up-to-date with the latest embroidery and garment decorating news, tips, sem-
inars and show information. If you want to continue to receive this quarterly
newsletter, Print & Sew Quarterly, you will have to sign up on our website. Simply
go to www.brother.com, click on ‘USA’, click on ‘Industrial Embroidery &
Sewing’, click on ‘Newsletter’, and follow the registration instructions at the bottom
of the page. You have the option to receive this informative newsletter via email or
regular mail.


